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Уведомление
Несмотря на то, что были приложены все усилия, чтобы 
информация в данном документе на момент его печати была 
полной и точной, компания Avaya не несет ответственности 
за любые ошибки. Компания Avaya оставляет за собой право 
вносить изменения и исправления в информацию данного 
документа без предварительного уведомления пользователей 
или организаций.
Отказ от ответственности за документацию
«Документация» — это информация, публикуемая на различных 
носителях. Данная информация может включать в себя сведения 
о продуктах, описания подписок или услуг, инструкции по 
использованию и технические характеристики, которые обычно 
предоставляются пользователям продуктов. К документации 
не относятся маркетинговые материалы. Компания Avaya не 
несет ответственности за любые изменения, дополнения или 
удаления, сделанные в оригинальной опубликованной версии 
документации, если эти изменения, дополнения или удаления 
не были сделаны компанией Avaya или от ее имени. Конечный 
пользователь обязуется не привлекать к ответственности и 
не предъявлять компании Avaya, ее агентам, служащим и 
сотрудникам какие-либо иски или требования и не инициировать 
против них судебные разбирательства в связи с изменениями, 
добавлениями и сокращениями, сделанными позднее в данной 
документации.
Отказ от ответственности за ссылки
Компания Avaya не несет ответственности за содержимое 
или работу любых ссылок, которые указаны компанией Avaya 
на этом веб-сайте или в документации. Компания Avaya не 
несет ответственности за точность информации, содержание 
и достоверность веб-сайтов, на которые имеются ссылки в 
данной документации, и наличие какой-либо ссылки не означает, 
что компания рекомендует соответствующие продукты, услуги 
или информацию. Компания Avaya не может гарантировать, 
что эти ссылки будут обеспечивать доступ к запрашиваемой 
информации в любой момент, так как она не контролирует 
указанные страницы.
Гарантия
Avaya предоставляет ограниченную гарантию на оборудование 
и программное обеспечение Avaya. Для получения условий 
ограниченной гарантии см. соглашение с Avaya. Условия 
стандартной гарантии Avaya и информация, которая касается 
гарантийного обслуживания данного продукта, доступна 
клиентам Avaya и любым другим лицам на веб-сайте 
службы технической поддержки Avaya: https://support.avaya.com/
helpcenter/getGenericDetails?detailId=C20091120112456651010 по 
ссылке «Гарантия и жизненный цикл продуктов» или на других 
последующих веб-сайтах, указанных компанией Avaya. Обратите 
внимание, что если продукт или продукты приобретены у 
авторизованного партнера Avaya по каналу за пределами США и 
Канады, гарантия предоставляется соответствующим партнером 
Avaya по каналу, а не компанией Avaya.
«Размещенная служба» — это подписка на размещенную 
службу Avaya, приобретенная вами у компании Avaya или 
авторизованного партнера Avaya по каналу (в зависимости от 
обстоятельств) и описанная в документации к размещенному 
SAS или иной применимой службе. В случае приобретения 
подписки на размещенную службу указанная выше ограниченная 
гарантия может не применяться, однако вы можете получить 
право на получение услуг поддержки в отношении размещенной 
службы, как описано в документации к соответствующей 
размещенной службе. Для получения подробной информации 
обращайтесь в Avaya или к партнеру Avaya по каналу (в 
зависимости от того, кто предоставляет службу).
Размещенная служба
СЛЕДУЮЩИЕ ПОЛОЖЕНИЯ ПРИМЕНЯЮТСЯ ТОЛЬКО ПРИ 
ПРИОБРЕТЕНИИ ПОДПИСКИ НА РАЗМЕЩЕННУЮ СЛУЖБУ 
AVAYA У AVAYA ИЛИ ПАРТНЕРА AVAYA ПО КАНАЛУ 
(В ЗАВИСИМОСТИ ОТ ОБСТОЯТЕЛЬСТВ), УСЛОВИЯ 
ИСПОЛЬЗОВАНИЯ РАЗМЕЩЕННЫХ СЛУЖБ ДОСТУПНЫ 

НА ВЕБ-САЙТЕ AVAYA, HTTPS://SUPPORT.AVAYA.COM/
LICENSEINFO ПО ССЫЛКЕ «Avaya Terms of Use for 
Hosted Services» (Условия использования размещенных 
служб Avaya) ИЛИ НА ДРУГИХ ПОСЛЕДУЮЩИХ ВЕБ-
САЙТАХ, УКАЗАННЫХ КОМПАНИЕЙ AVAYA, И ПРИМЕНЯЮТСЯ 
КО ВСЕМ ЛИЦАМ, ОБРАЩАЮЩИМСЯ К РАЗМЕЩЕННОЙ 
СЛУЖБЕ ИЛИ ИСПОЛЬЗУЮЩИМ ЕЕ. ПРИ ДОСТУПЕ 
ИЛИ ИСПОЛЬЗОВАНИИ РАЗМЕЩЕННОЙ СЛУЖБЫ ИЛИ 
ПРЕДОСТАВЛЕНИИ ТАКИХ ВОЗМОЖНОСТЕЙ ДРУГИМ ЛИЦАМ 
ОТ СВОЕГО ИМЕНИ И ОТ ИМЕНИ СУБЪЕКТА, ДЛЯ КОТОРОГО 
ВЫ ОСУЩЕСТВЛЯЕТЕ ЭТО (ДАЛЕЕ «ВЫ» И «КОНЕЧНЫЙ 
ПОЛЬЗОВАТЕЛЬ»), ВЫ СОГЛАШАЕТЕСЬ С УСЛОВИЯМИ 
ИСПОЛЬЗОВАНИЯ. ЕСЛИ ВЫ СОГЛАШАЕТЕСЬ С УСЛОВИЯМИ 
ИСПОЛЬЗОВАНИЯ ОТ ИМЕНИ КОМПАНИИ ИЛИ ДРУГОГО 
ЮРИДИЧЕСКОГО ЛИЦА, ВЫ ПОДТВЕРЖДАЕТЕ, ЧТО У 
ВАС ЕСТЬ ПОЛНОМОЧИЯ НА ПОЛУЧЕНИЕ СОГЛАСИЯ 
ЭТОГО ЛИЦА С УСЛОВИЯМИ ИСПОЛЬЗОВАНИЯ. ЕСЛИ У 
ВАС ОТСУТСТВУЮТ ТАКИЕ ПОЛНОМОЧИЯ ИЛИ ВЫ НЕ 
СОГЛАШАЕТЕСЬ С ЭТИМИ УСЛОВИЯМИ ИСПОЛЬЗОВАНИЯ, 
ВЫ НЕ ИМЕЕТЕ ПРАВА ОБРАЩАТЬСЯ К РАЗМЕЩЕННОЙ 
СЛУЖБЕ И ИСПОЛЬЗОВАТЬ ЕЕ ЛИБО ПРЕДОСТАВЛЯТЬ КОМУ-
ЛИБО ПРАВО НА ОБРАЩЕНИЕ К РАЗМЕЩЕННОЙ СЛУЖБЕ И 
ЕЕ ИСПОЛЬЗОВАНИЕ.
Лицензии
Глобальные условия предоставления лицензии на программное 
обеспечение («Условия предоставления лицензии на 
программное обеспечение») доступны на следующем веб-
сайте https://www.avaya.com/en/legal-license-terms/ или любом 
заменяющем его сайте, указанном Avaya. Настоящие Условия 
предоставления лицензии на программное обеспечение 
распространяются на любого, кто устанавливает, загружает и/или 
использует Программное обеспечение и/или Документацию. 
При установке, загрузке и использовании программного 
обеспечения, а также разрешая другим лицам его использовать, 
конечный пользователь соглашается с данными условиями 
предоставления лицензии на программное обеспечение 
и вступает в юридическое соглашение между конечным 
пользователем и компанией Avaya. Если конечный пользователь 
принимает настоящие условия предоставления лицензии на 
программное обеспечение от имени той или иной компании 
или другого юридического лица, то настоящим конечный 
пользователь подтверждает, что обладает необходимыми 
полномочиями для связывания этого юридического лица 
настоящими условиями предоставления лицензии на 
программное обеспечение.
Охраняется авторским правом
За исключением случаев, когда явно указано иное, запрещается 
использовать приведенные на этом веб-сайте материалы, 
документацию, программное обеспечение, размещенные службы 
и оборудование, предоставленные компанией Avaya. Все 
содержимое этого веб-сайта, документация, размещенная 
служба и продукт, предоставленные компанией Avaya, в 
том числе подборка, размещение и дизайн содержимого, 
принадлежит компании Avaya или ее лицензиарам, а также 
защищено законом об охране авторских прав и другими 
законами по защите прав на интеллектуальную собственность, 
в том числе законами по охране прав на уникальные 
объекты в отношении защиты баз данных. Запрещается 
изменять, копировать, воспроизводить, публиковать, загружать 
на серверы, передавать и распространять любым способом 
любое содержимое целиком или частично, в том числе 
любой код и программное обеспечение, если это в явной 
форме не разрешено компанией Avaya. Несанкционированное 
воспроизведение, передача, распространение, хранение и 
использование без явного письменного согласия компании Avaya 
может представлять собой состав уголовного преступления или 
гражданского правонарушения в соответствии с применимым 
законодательством.
Виртуализация
Следующие положения применимы только в случае 
развертывания продукта на виртуальной машине. Каждый 
продукт имеет собственный код заказа и типы лицензии. Если 
не оговорено иное, каждый экземпляр продукта заказывается 
и лицензируется отдельно. Например, если клиент конечного 
пользователя или партнера Avaya по каналу хочет установить 
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два экземпляра одного типа продуктов, необходимо заказать два 
продукта этого типа.
Компоненты сторонних производителей
Следующие положения применимы только в случае 
поставки кодека H.264 (AVC) вместе с продуктом. 
ДАННЫЙ ПРОДУКТ ЛИЦЕНЗИРУЕТСЯ ПО УСЛОВИЯМ 
ЛИЦЕНЗИИ НА ПОРТФЕЛЬ ПАТЕНТОВ AVC ДЛЯ 
ЛИЧНОГО ИСПОЛЬЗОВАНИЯ ПОТРЕБИТЕЛЕМ ИЛИ ДЛЯ 
ИСПОЛЬЗОВАНИЯ ИНЫМИ СПОСОБАМИ, ИСКЛЮЧАЮЩИМИ 
ПОЛУЧЕНИЕ ВОЗНАГРАЖДЕНИЯ ЗА (i) КОДИРОВАНИЕ 
ВИДЕО В СООТВЕТСТВИИ СО СТАНДАРТОМ AVC 
(«ВИДЕО AVC») И/ИЛИ (ii) ДЕКОДИРОВАНИЕ ВИДЕО 
AVC, ЗАКОДИРОВАННОГО ПОТРЕБИТЕЛЕМ В ПРОЦЕССЕ 
ЛИЧНОГО ИСПОЛЬЗОВАНИЯ И/ИЛИ ПОЛУЧЕННОГО ОТ 
ПОСТАВЩИКА ВИДЕО, ИМЕЮЩЕГО ЛИЦЕНЗИЮ НА 
ПРЕДОСТАВЛЕНИЕ ВИДЕО AVC. ДЛЯ ДРУГИХ ВИДОВ 
ИСПОЛЬЗОВАНИЯ ЛИЦЕНЗИЯ НЕ ПРЕДОСТАВЛЯЕТСЯ И 
НЕ ПОДРАЗУМЕВАЕТСЯ. ДОПОЛНИТЕЛЬНУЮ ИНФОРМАЦИЮ 
МОЖНО ПОЛУЧИТЬ У MPEG LA, L.L.C. СМ. ВЕБ-САЙТ ПО 
АДРЕСУ HTTP://WWW.MPEGLA.COM.
Поставщик услуг
ЧТО КАСАЕТСЯ КОДЕКОВ, ЕСЛИ ПАРТНЕР AVAYA ПО КАНАЛУ 
РАЗМЕЩАЕТ КАКИЕ-ЛИБО ПРОДУКТЫ, ИСПОЛЬЗУЮЩИЕ 
ИЛИ ИМЕЮЩИЕ ВНЕДРЕННЫЙ КОДЕК H.264 ИЛИ 
H.265, ПАРТНЕР AVAYA ПО КАНАЛУ ПОДТВЕРЖДАЕТ 
И СОГЛАШАЕТСЯ СО СВОЕЙ ОТВЕТСТВЕННОСТЬЮ 
ЗА УПЛАТУ ВСЕХ СВЯЗАННЫХ КОМИССИЙ И/ИЛИ 
РОЯЛТИ. КОДЕК H.264 (AVC) ЛИЦЕНЗИРУЕТСЯ ПО 
УСЛОВИЯМ ЛИЦЕНЗИИ НА ПОРТФЕЛЬ ПАТЕНТОВ AVC 
ДЛЯ ЛИЧНОГО ИСПОЛЬЗОВАНИЯ ПОТРЕБИТЕЛЕМ ИЛИ ДЛЯ 
ИСПОЛЬЗОВАНИЯ ИНЫМИ СПОСОБАМИ, ИСКЛЮЧАЮЩИМИ 
ПОЛУЧЕНИЕ ВОЗНАГРАЖДЕНИЯ ЗА (i) КОДИРОВАНИЕ 
ВИДЕО В СООТВЕТСТВИИ СО СТАНДАРТОМ AVC 
(«ВИДЕО AVC») И/ИЛИ (ii) ДЕКОДИРОВАНИЕ ВИДЕО 
AVC, КОТОРОЕ БЫЛО ЗАКОДИРОВАНО ПОТРЕБИТЕЛЕМ В 
ПРОЦЕССЕ ЛИЧНОГО ИСПОЛЬЗОВАНИЯ И/ИЛИ ПОЛУЧЕНО 
ОТ ПОСТАВЩИКА ВИДЕО, ИМЕЮЩЕГО ЛИЦЕНЗИЮ НА 
ПРЕДОСТАВЛЕНИЕ ВИДЕО AVC. ДЛЯ ДРУГИХ ВИДОВ 
ИСПОЛЬЗОВАНИЯ ЛИЦЕНЗИЯ НЕ ПРЕДОСТАВЛЯЕТСЯ И НЕ 
ПОДРАЗУМЕВАЕТСЯ. ДОПОЛНИТЕЛЬНУЮ ИНФОРМАЦИЮ ПО 
КОДЕКАМ H.264 (AVC) и H.265 (HEVC) МОЖНО ПОЛУЧИТЬ 
В КОМПАНИИ MPEG LA, L.L.C. СМ. ВЕБ-САЙТ ПО АДРЕСУ 
HTTP://WWW.MPEGLA.COM.
Соблюдение требований законодательства
Клиент признает и соглашается с тем, что он несет 
ответственность за соблюдение всех применимых законов 
и норм, в том числе за соблюдение законов и норм, 
связанных с записью вызовов, конфиденциальностью данных, 
интеллектуальной собственностью, коммерческой тайной, 
мошенничеством и правами на исполнение музыкальных 
произведений на территории страны или региона, где 
используется продукт Avaya.
Предупреждение мошеннического использования телефона
«Мошенническим использованием системы» 
является несанкционированное использование вашей 
телекоммуникационной системы некоторой стороной без 
разрешения (например, лицом, которое не является 
служащим компании, оператором, подрядчиком или работником, 
выполняющим задание для вашей компании). Учтите, что в 
связи с наличием телекоммуникационной системы существует 
риск мошеннического использования телефона, которое может 
привести к значительным дополнительным расходам за услуги 
связи.
Поддержка от компании Avaya в случае мошеннического 
использования телефона
Если вы подозреваете, что стали жертвой телефонного 
мошенничества и нуждаетесь в технической помощи, обратитесь 
к торговому представителю компании Avaya.
Уязвимости системы безопасности
Информация о политике обеспечения безопасности компанией 
Avaya приведена в разделе Security Policies and Support 

(Политика безопасности и поддержка) на веб-сайте https://
support.avaya.com/security.
Предполагаемые уязвимости в безопасности продуктов 
Avaya обрабатываются в рамках процедуры обеспечения 
безопасности продуктов Avaya (https://support.avaya.com/css/P8/
documents/100161515).
Товарные знаки
Товарные знаки, логотипы и знаки обслуживания (далее 
«Знаки»), представленные компанией Avaya на веб-сайте, в 
Документации, Размещенных службах и продуктах, являются 
зарегистрированными или незарегистрированными Знаками 
компании Avaya, ее дочерних компаний, лицензиаров, 
поставщиков или сторонних компаний. Пользователям 
запрещено использовать такие знаки без предварительного 
письменного разрешения компании Avaya или третьих 
лиц, которым принадлежат соответствующие Знаки. Никакие 
элементы и сведения на этом веб-сайте, в Документации, в 
Размещенных службах и в продуктах не могут рассматриваться 
как предоставляющие по смыслу или по отсутствию права 
возражения или иным образом какие-либо лицензии или права 
на них и на Знаки без явного письменного разрешения компании 
Avaya или соответствующего третьего лица.
Avaya является зарегистрированным товарным знаком компании 
Avaya LLC.
Все товарные знаки, не принадлежащие компании Avaya, 
являются собственностью их владельцев.
Linux® является зарегистрированным в США и других странах 
товарным знаком, принадлежащим Линусу Торвальдсу (Linus 
Torvalds).
Скачивание документации
Актуальные версии документации см. на веб-сайте службы 
поддержки Avaya https://support.avaya.com или на заменяющем 
его сайте, указанном компанией Avaya.
Контакты службы поддержки Avaya
Перейдите на веб-сайт службы поддержки Avaya https://
support.avaya.com, чтобы ознакомиться с замечаниями и 
статьями по продуктам и облачным службам или сообщить 
об ошибках, которые возникли в вашем продукте или 
облачной службе Avaya. Для получения списка телефонных 
номеров службы поддержки и контактных адресов посетите 
веб-сайт службы поддержки Avaya https://support.avaya.com (или 
заменяющий его сайт, указанный компанией Avaya), прокрутите 
страницу вниз и выберите «Связаться со службой технической 
поддержки Avaya».
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Глава 1.  Использование IP Office 
SoftConsole

Это руководство содержит инструкции по использованию приложения IP Office SoftConsole. 
Это приложение для Windows предназначено для администраторов и операторов. Оно 
включает функции, позволяющие вручную обрабатывать и распределять входящие вызовы.

Дополнительные ссылки
Phone and computer requirements на стр. 7
Вход в систему на стр. 8
Optional Login Setting на стр. 9
Изменение языка на стр. 9
Поддерживаемые языки на стр. 10

Phone and computer requirements
Ensure you meet the following requirements before using the console.

Details
Sound and media Sound and media files can be associated with calls. If you use this functionality, you must 

have a sound card and speakers set up on your computer.

Table continues…

March 2024 Using IP Office SoftConsole 7
Комментарии к документу? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=UsingIPOfficeSoftConsole&p3=10


Details
Telephone support You must have an extension to provide the speech path for calls. We recommend that 

you use the console with a phone that supports auto-answer. That applies to most Avaya 
desk phones.

• Auto-Answer Phones – On these phones, the console is able to make calls which are 
immediately connected to the phone in order to hear the call progress.

• Non Auto-Answer Phones – On these phones, when making a call using the console, 
the system first calls you and only makes the outgoing call after you answer. This 
typically applies to:

- Analog phones and most DECT/non–Avaya SIP phones do not support auto-answer.

- Avaya telephony applications running on a PC or mobile phone.

The telephone system also supports users who can make and answer calls on multiple 
telephone devices simultaneously. This is not supported by the console. It will associate 
itself with one of the user’s available telephone devices and only make/answer calls 
using that device. Where one of those devices is a desk phone on the telephone system, 
it will use that device.

Вход в систему
Об этой задаче
Чтобы использовать панель, необходимо войти в систему. Окно Login содержит данные, 
позволяющие установить соединение между консолью и телефонной системой.

Процедура

1. Щелкните  SoftConsole.

2. В окне Login выполните следующие действия:

a. Введите имя пользователя или внутренний номер с учетом регистра.

b. Введите пароль пользователя.

c. Введите имя или IP-адрес телефонной системы.

• Если вы установили приложение, скачанное из Web Manager или с портала 
самоадминистрирования, его имя добавится автоматически.

d. Установите флажок Use secure communications, чтобы обеспечить безопасное 
соединение между консолью и телефонной системой.

3. Чтобы настроить дополнительные параметры перед входом в систему, нажмите 
Expand. См. Optional Login Setting на стр. 9

4. Чтобы войти в систему, нажмите OK.

Использование IP Office SoftConsole
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Optional Login Setting
The following additional settings are displayed on the login menu if you click Expand.

Profile settings
Whilst using the console, you can rearrange the windows displayed and other settings such as the 
console language. When you logout, you will be prompted to save any changes as a profile.
In addition, your system administrator can create a set of default templates.
The Profiles setting on the login menu allows you to select and reapply the settings of a default or 
previously saved profile.

Telephony options
The following describes the check boxes in the Telephony section.

Option Description
Call waiting When selected, the system provides a call waiting tone when you are on a call and 

another incoming call arrives. When you end the current call, the new call is immediately 
presented to you. This option is ignored if you have multiple call appearances on your 
telephone.

Off-hook station When selected, this option enables receptions to use the hands-free features on their 
telephones. The console controls the operation of the telephone. You should only 
deselect this option if you have an analog telephone where you answer or end calls 
using the handset.

Show templates When selected, the default console templates are included in the list of profiles.

Изменение языка
Об этой задаче
В этом разделе описано, как настроить или изменить язык приложения консоли.

Процедура
1. Выберите View > Languages.

2. Выберите необходимый язык.

3. Щелкните , чтобы сохранить изменения в своем профиле.

Дополнительные ссылки
Использование IP Office SoftConsole на стр. 7

Optional Login Setting
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Поддерживаемые языки
Консоль поддерживает следующие языки:

• бразильский, китайский, датский, английский (Великобритания), английский 
(США), финский, французский, немецкий, итальянский, корейский, японский, 
латиноамериканский испанский, норвежский, португальский, русский и шведский.

Использование IP Office SoftConsole

March 2024 Using IP Office SoftConsole 10
Комментарии к документу? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=UsingIPOfficeSoftConsole&p3=10


Глава 2.  Меню и элементы управления

В этом разделе представлен обзор меню и элементов управления приложения.

Дополнительные ссылки
The Main Window на стр. 11
Компактный вид на стр. 13
Call history view на стр. 13
BLF panel на стр. 14
The call detail panel на стр. 15
Status bar на стр. 17
Main menu bar на стр. 17
Toolbar buttons на стр. 18
Shortcut keys на стр. 19

The Main Window
In normal view mode, the screen is divided into the possible areas shown in the following image. 
The profile or template you select when logging in sets whether held calls, BLF, and park slots are 
shown.
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Option Description
1. Title bar Contains the name of the logged in person. By default, the title bar appears in the 

following colors:

• Red when the console is the active program.

• Grey if the console is not the active program.
2. Menu bar Commands and actions are available through menus. Some items are only accessible 

when the right conditions occur, such as a ringing call.
3. Toolbar Provides shortcuts for options that are frequently used. The toolbar can be shown or 

hidden using the View menu.
4. Call details 
panel

Contains a side-by-side display of current call information. The panel on the left contains 
details of the current or alerting call.

5. Directory panel The panel on the right contains the directory and individual extension details. The panel 
on the right can also contain a script file or conferencing details.

6. Queue panel Displays graphical information on the status of calls held in queues.
7. Held calls panel Lists call that are on hold.
8. BLF panel Displays icons that represent numbers you can dial. If the icons represent internal users, 

the user status is indicated.
9. Park slots panel Contains up to 16 Park Slot buttons.

Table continues…
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Option Description
10. Status bar Confirms that you are connected to the telephone system and the profile that you are 

using. The bar also displays the number of new messages and missed calls.
11. Call history 
panel

Shows a list of recent incoming, outgoing, and missed calls. When selected, the call 
history replaces the Held calls and BLF panels.

Компактный вид
Консоль можно запустить в обычном или компактном режиме. В компактном режиме 
отображаются только панель сведений о вызове и справочники.

Процедура
1. Вот как переключиться между компактным и нормальным режимом:

• Щелкните .

• Щелкните View > Compact или Normal View.

2. Чтобы переключиться между компактным и нормальным режимом, нажмите клавишу 
Home.

Дополнительные ссылки
Меню и элементы управления на стр. 11

Call history view
You can switch between displaying the call history and the BLF/held calls panels. The call history 
displays details of calls made and received by the console.

Компактный вид
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The panel is divided into the following tabs:

Name Description
In Lists all calls received at your extension.

Out Lists all calls made from your extension.
Missed Lists all unanswered calls to your extension.

All Lists all incoming, outgoing, and missed calls.

• The number in brackets after each tab name is the number of calls listed.
• Each tab can display a maximum of 100 calls.
• When the maximum capacity is reached, the oldest record is deleted to add a new record.

Within each tab, there are the following call status icons and information:

Name Description

Out ( ) Indicates a call that was made from your extension.

In ( ) Indicates a call that was made to your extension.

Missed calls ( ) Indicates a call that was not answered.

Number Either the incoming telephone number or the telephone number that was called.
From The name that is associated with the number in the directory on the main system or your 

local console directory.
To The name that is associated with the called number in the directory on the main system 

or your local console directory.
Tag Text that was entered to identify the call.
Date

Time

The date and time that the call occurred.

BLF panel
The Busy Lamp Field (BLF) panel displays named icons that represent dialable numbers. If the 
icon is for an internal user, the user’s status is indicated.

Меню и элементы управления
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The panel uses tabs to group different sets of user icons. You can switch between the groups by 
clicking the tab name.
The icons used for users are:

Icon Description
Unread Voicemail Messages

A yellow envelope indicates that the user has unread voicemail messages. The number of 
messages appear in brackets.
User Busy

A red circle with white cross indicates the user is busy.

Forwarding All

A green circle with a white arrow indicates that all calls to the user are currently being 
forwarded.
Do Not Disturb

A blue circle with white cross indicates that the user has Do Not Disturb switched on.

The call detail panel
The call details panel contains a side-by-side display of current call information. A slider positioned 
between the two panels allows you to adjust the size of the panels as required.

The panel on the left contains details about the current calls. When a single call is in progress, 
either ringing or connected, the panel contains details for that call.

The call detail panel
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If you have multiple call appearances set, additional calls are shown when they arrive. Clicking 
the separate calls has the same effect as pressing the matching call appearance buttons on the 
telephone: The selected call is answered, and previously connected calls are automatically put on 
hold.

The following details can be shown for a single call:

Call detail Description
Calling name The name associated with the calling number. For external calls, this can be a name 

obtained from a calling number match with the telephone system directory.
Calling number The telephone number of the caller, if available.

Called name The name associated with the called number.
Called number The extension number to which the telephone system routed the incoming call.

Call status The progress of the call. The border around the panel changes color to indicate the 
status of a call. The following default colors are associated with call status:

• Red: Alerting incoming or outgoing call.

• Green: Connected call, or call still being dialed.

• Yellow: Returned or timed out call. For example, a held call that has timed out from 
hold.

• Black: Idle state.
Duration The length of time that the call is in its current state. Examples of states include ringing, 

connected, or held.
Notes Displays notes or information about the call, including any annotations that are added. 

For example, when a call returns, the reason for the return is shown.

Меню и элементы управления
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Status bar
The status bar confirms that you are connected to the telephone system and the profile that you 
are using. An indicator also displays the number of new messages and missed calls that you 
have.

Status Description
Connected

Disconnected

Displays whether the console application is connected to the telephone system.

IM connected

IM disconnected

Displays whether the console application is connected to the instant messaging server.

Missed calls Displays the number of missed calls currently in the call history.
New messages Displays the number of new messages in your mailbox.

Main menu bar
The main menu bar is at the top of the screen. You can open each menu using the following 
methods:

• Clicking the Menu button.
• Pressing Alt and the underlined letter for the required menu on your keyboard. For example, 

press Alt + A to open the menu.

Menu option Description
File You can do the following:

• Save the current application setup as a personal profile.

• Log in with a different profile.

• Exit the application.
View You can run the application in normal or compact mode, and you can choose to view 

call history. You can also select the display language and whether to show or hide the 
toolbar.

If you are in Administrator mode, you can also choose to show or hide the BLF, held 
calls, and park slot panels.

Actions This menu contains actions for call handling. Those that are unavailable are not 
applicable to the current call situation. Keyboard shortcuts for the functions are also 
shown in this menu.

Table continues…
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Menu option Description
Directory You can view, search, export, and set up the directory.

Tools You can use this menu to access other menus for various functions.
Help This menu provides access to the help system and details about the console.

Toolbar buttons
Main toolbar
You can show or hide the main toolbar by selecting View > Toolbar. The main toolbar contains the 
following buttons:

Icon Description
Login

Save Profile

Make call
Answer

Hold

Transfer

Transfer complete

Reattempt transfer

Conference

Hang up

Page

Record Call

Compact View

Dial pad

Conference room 2

Conference room 2

Preferences

Directory buttons
The buttons across the top of the directory are used as follows:

Меню и элементы управления
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Icon Description
Make a call to the selected directory entry.
Edit the properties of the selected directory entry.

Use the directory panel to view directory entries.

Use the directory panel to view conferences being hosted by the telephone system.

Show or hide telephone system users in the directory panel.

Show or hide telephone system hunt groups in the directory panel.

Show or hide telephone numbers from the telephone system directory, local console 
directory, and Outlook. You can:

• Select which directories are included with the Directoriestab.

• Edit the local console directory with the Incoming Calls tab.

Held calls panel buttons
Icon Description

Answer the selected held call.

Answer the longest held call.

Conference the held calls.

Transfer the selected held call.

Shortcut keys
The following tables list the default shortcut keys. You can adjust these assignments through the 
console configuration menus.

Call control shortcuts
Shortcut Description
Ctrl + A Alternate calls
F11 Annotate call
Enter Answer call
F12 Make new call
End Hang up
F4 Hold call
F7 Hold the current call and auto answer next call
Ctrl + B Hold the current call against a busy extension

Table continues…
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Shortcut Description
F9 Intrude
F10 Page
F6 Reclaim call
F5 Record call
F2 Transfer call
Ctrl + T Transfer complete

Ctrl + R Reattempt the transfer of a returned call
F3 Transfer to voicemail
Shift + Ctrl + F10 Add to conference

Shift + Ctrl + F11 Add to conference room 1

Shift + Ctrl+ F12 Add to conference room 2

Application hot keys
Shortcut Description
Pause Restore application
Home Switch between normal view and compact view

BLF shortcuts
Shortcut Description
Ctrl + Alt + C Call selected BLF group member

Ctrl + Alt + G BLF large icon view

Ctrl + Alt + S BLF small icon view

Ctrl + Alt + I BLF list view

Ctrl + Alt + D BLF details view

Ctrl + Alt + N Arrange BLF icons by name

Ctrl + Alt + M Arrange BLF icons by number

Ctrl + Alt + U Arrange BLF icons by status

Ctrl + Alt + H Arrange BLF icons horizontally

Ctrl + Alt + V Arrange BLF icons vertically

Ctrl + Alt + R Create new BLF group

Ctrl + Alt + B Create new BLF group member

Ctrl + Alt + P Edit BLF group/member properties

Меню и элементы управления
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Directory shortcuts
Shortcut Description
Ctrl + S New directory search

Ctrl + C Call selected directory entry

Ctrl + P Display properties of selected entry

Shift + Enter Display search item details of selected entry

Ctrl + E Send email to selected user

Ctrl + M Send text message to selected user

Ctrl + I Send instant message to selected user

Ctrl + Y Directory view

Ctrl + F Conference view

Ctrl + U Show/hide user entries

Ctrl + G Show/hide group entries

Ctrl + D Show/hide directory entries

Held calls shortcuts
Shortcut Description
Ctrl + Alt + A Answer held call

Ctrl + Alt + L Answer longest held call
F8 Conference with held calls
Ctrl + Alt + T Transfer held call

Ctrl + Alt + P Edit BLF group/member properties

Queue mode shortcuts
Shortcut Description
Shift + F1 Pickup call from queue 1

Shift + F2 Pickup call from queue 2

Shift + F3 Pickup call from queue 3

Shift + F4 Pickup call from queue 4

Shift + F5 Pickup call from queue 5

Shift + F6 Pickup call from queue 6

Shift + F7 Pickup call from queue 7

Shift + F8 Pickup call from queue 8

Shortcut keys
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Tool shortcuts
Shortcut Description
Shift + Ctrl + F4 Conference room 1

Shift + Ctrl + F5 Conference room 2

Shift + Ctrl + F1 Release door 1

Shift + Ctrl + F2 Release door 2

Shift + Ctrl + F3 Dial pad

Ctrl + V Call voicemail

Park slot shortcuts
Shortcut Description
Alt + F1 Pack/unpark call in park slot 1

Alt + F2 Pack/unpark call in park slot 2

Alt + F3 Pack/unpark call in park slot 3

Alt + F4 Pack/unpark call in park slot 4

Alt + F5 Pack/unpark call in park slot 5

Alt + F6 Pack/unpark call in park slot 6

Alt + F7 Pack/unpark call in park slot 7

Alt + F8 Pack/unpark call in park slot 8

Alt + F9 Pack/unpark call in park slot 9

Alt + F10 Pack/unpark call in park slot 10

Alt + F11
Pack/unpark call in park slot 11

Alt + F12 Pack/unpark call in park slot 12

Shift + F9 Pack/unpark call in park slot 13

Shift + F10 Pack/unpark call in park slot 14

Shift + F11 Pack/unpark call in park slot 15

Shift + F12 Pack/unpark call in park slot 16

Related links
Меню и элементы управления on page 11

Меню и элементы управления
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Глава 3.  Обработка вызовов

В этом разделе описаны основные элементы управления для обработки вызовов в 
приложении.

Дополнительные ссылки
Ответ на входящие вызовы на стр. 23
Набор номера DTMF на стр. 24
Постановка вызовов на удержание на стр. 25
Парковка вызовов и отмена парковки на стр. 25
Collecting parked calls на стр. 26
Возобновление вызовов на стр. 26
Переключение между журналом вызовов и панелями BLF/«Вызовы на удержании» на 
стр. 27
Мониторинг очередей на стр. 27
Добавление текста комментария к вызову на стр. 28
Открытие управляемых дверей на стр. 29
Прерывание вызовов на стр. 30
Отправка текстовых сообщений на стр. 30
Отправка мгновенных сообщений на стр. 31
Отправка сообщений электронной почты на стр. 32
Выполнение пейджингового вызова на стр. 33
Запись вызовов на стр. 34
Получение сообщений голосовой почты на стр. 34

Ответ на входящие вызовы
Об этой задаче
Когда поступает входящий вызов, панель вызова выделяется красной рамкой и показывает 
сведения о вызывающем абоненте. Если со входящим вызовом связан файл сценария, 
сценарий отображается на панели справа.
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Процедура
1. Вот как ответить на вызов:

• Нажмите клавишу Enter.

• Щелкните .

• Щелкните Actions > Answer.
• Поднимите трубку (если используется телефон).

• Дважды щелкните панель вызова.

После ответа на вызов сведения о вызывающем абоненте выделяются зеленой 
рамкой.

2. Если отображается сценарий, то чтобы убрать его, щелкните Close Script или снова 
нажмите клавишу Enter.

Дополнительные ссылки
Обработка вызовов на стр. 23

Набор номера DTMF
Об этой задаче
Клавиатура для набора на консоли позволяет набрать номер DTMF во время вызова.

Процедура

1. Во время вызова выберите Tools > Dial pad. Или щелкните значок .

2. Выберите DTMF Dialing.

Теперь любой набираемый номер будет передаваться в текущий подключенный 
вызов как номер DTMF.

Дополнительные ссылки
Обработка вызовов на стр. 23

Обработка вызовов
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Постановка вызовов на удержание
Об этой задаче
Вы можете поставить вызов на удержание, чтобы выполнить другую задачу.

Процедура

1. Щелкните значок  или нажмите клавишу F4.

Чтобы одновременно поставить текущий вызов на ожидание и ответить на 
следующий вызов, нажмите клавишу F7.

Панель вызовов на удержании содержит список всех удерживаемых вызовов.

2. Отсортируйте список, щелкнув заголовок соответствующего столбца.

3. Щелкните строку в списке, чтобы выбрать вызов, который нужно принять или 
передать.

4. По необходимости используйте значки вверху панели.

Дополнительные ссылки
Обработка вызовов на стр. 23

Парковка вызовов и отмена парковки
Об этой задаче
Вы можете запарковать вызов, чтобы выполнить другие задачи. Например, вызывающему 
абоненту срочно необходимо поговорить с кем-то, но этот человек недоступен. Вы можете 
запарковать вызов на слоте 1 и отправить пейджинговый вызов нужному абоненту с 
просьбой принять вызов в указанном слоте.
Перед возвратом оператору вызовы остаются запаркованными определенное время. Для 
получения дополнительной информации о времени парковки обратитесь к системному 
администратору.
Доступно 16 слотов для парковки. Когда вызов паркуется в определенном слоте, метка 
кнопки показывает сведения о вызове. Если слот свободен, метка кнопки показывает его 

Постановка вызовов на удержание
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номер. Все операторы видят, принят вызов или завершен. Любой из них может ответить на 
ожидающий вызов.

Процедура
1. Чтобы запарковать вызов, при подключении к вызову нажмите свободную кнопку 

Park Slot, чтобы запарковать вызов в этом слоте.

Для запаркованного вызова показана необходимая информация, например исходный 
номер вызова.

2. Чтобы снять вызов с парковки, нажмите соответствующую кнопку Park Slot.
Дополнительные ссылки

Обработка вызовов на стр. 23

Collecting parked calls
About this task
When you park a call, anyone who knows the slot number can pick up the call.

Procedure
To pick up a parked call, do one of the following:

• Dial the default short code *38*N# where N is the park slot number.

• If console users have a park slot button set to the same park slot number, the button indicates 
the parked call. They can click the button to unpark the call.

• On Avaya telephones with programmable buttons, users can program buttons to match 
particular park slot numbers. The button indicates when a call is parked in that park slot and can 
be pressed to unpark the call.

Related links
Обработка вызовов on page 23

Возобновление вызовов
Об этой задаче
Вы можете попытаться возобновить последний входящий вызов, представленный на 
консоли, в том числе принятый на другом номере. Вызов можно возобновить, если он 
ожидает ответа или, возможно, был передан не на тот номер.
При работе в группе пользователей консоли эта функция позволяет возобновить вызов, 
который был представлен вам, но принят другим пользователем.

Обработка вызовов
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Процедура
Нажмите клавишу F6 или щелкните Actions > Reclaim Call.

Дополнительные ссылки
Обработка вызовов на стр. 23

Переключение между журналом вызовов и панелями 
BLF/«Вызовы на удержании»

Об этой задаче
На консоли можно переключаться между журналом вызовов и панелями BLF/«Вызовы на 
удержании».

Процедура
Щелкните View > Call History.

Дополнительные ссылки
Обработка вызовов на стр. 23

Мониторинг очередей
Об этой задаче
Для групп схожих операторов можно настроить очереди. Когда количество вызовов, 
ожидающих ответа, превышает число доступных операторов, дополнительные вызовы 
ставятся в очередь. В консоли можно настроить мониторинг до 8 очередей групп схожих 
операторов.
Количество вызовов, удерживаемых в очереди, показано с помощью линейчатой 
диаграммы.

Общее количество вызовов показано в конце линейчатой диаграммы. Если порог для 
активации аварийного сигнала не превышен, каждый вызов показан в виде белого квадрата. 
Если количество вызовов в очереди превышает этот порог, вызовы сверх этого порога 
показаны в виде оранжевого квадрата.

Переключение между журналом вызовов и панелями BLF/«Вызовы на удержании»
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Наибольшее время нахождения вызова в очереди указано в текстовом поле в конце 
диаграммы. Каждый раз, когда вызов ставится в очередь, время обновляется. Если порог 
для активации аварийного сигнала не превышен, время показано белым цветом. Если же 
порог превышен, цвет меняется на оранжевый.

Процедура
Наведите указатель мыши на активную панель Queue Call, чтобы просмотреть сведения об 
очереди.

Отобразится следующая информация:

• Queue Name
• Calls in Queue
• Recall Calls
• Status

Дополнительные ссылки
Обработка вызовов на стр. 23
Ответ на вызовы в очереди на стр. 28

Ответ на вызовы в очереди
Об этой задаче
Любой оператор консоли может отвечать на вызовы, поставленные в очередь. Вам не нужно 
быть участником группы схожих операторов, чтобы ответить на вызов.

Процедура
1. Нажмите кнопку Queue Name или воспользуйтесь сочетаниями клавиш от Shift+F1 

до Shift+F8.

Вам будет представлен первый вызов в очереди.

2. Ответьте на вызов обычным способом.

Дополнительные ссылки
Мониторинг очередей на стр. 27

Добавление текста комментария к вызову
Об этой задаче
К любому вызову можно добавить текстовую строку. Эта функция называется маркировкой 
или комментированием вызова. Текст сохраняется при передаче вызова и отображается на 
дисплее внутренних телефонов, принимающих вызов. Текст также записывается в журнале 
вызовов.
С помощью консоли можно добавить комментарий в ходе выполнения или передачи вызова. 
Кроме того, можно добавить комментарий при подключении к вызову.

Обработка вызовов
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Процедура
1. Для этого в ходе выполнения или передачи вызова выберите Actions > Annotate Call 

или нажмите клавишу F11.

2. Введите примечания в поле Call Notes.

Используйте буквенно-числовые символы, за исключением запятых.

По умолчанию максимальная длина текста составляет 16 символов, но ее может 
изменить администратор.

3. Щелкните OK.

Дополнительные ссылки
Обработка вызовов на стр. 23

Открытие управляемых дверей
Об этой задаче
Вы можете открыть управляемую дверь, не покидая рабочего места. Например, 
телефонный коммутатор можно подключить к реле, которое управляет дверью погрузочной 
площадки. Когда кому-то необходим доступ к погрузочной площадке, вы можете 
разблокировать дверь.
Обратите внимание, эта функция доступна, только если указано имя двери.
Можно управлять не более чем двумя дверьми. По умолчанию двери разблокируются на 
5 секунд.

Процедура
1. Щелкните Tools > Door Entry.

2. Щелкните имя необходимой двери, чтобы разблокировать ее.

Дополнительные ссылки
Обработка вызовов на стр. 23

Открытие управляемых дверей
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Прерывание вызовов
Об этой задаче
Прерывание вызовов доступно, только если у вас есть соответствующее разрешение, а 
другие внутренние стороны разрешили вам прерывать вызовы. Для включения возможности 
прерывания обратитесь к системному администратору.

Процедура
1. Найдите пользователя на панели справочника.

2. Щелкните Actions > Intrude или нажмите клавишу F9.

3. Поговорите с пользователем.

Обе стороны вызова могут вас слышать.

4. Если необходимо прервать вызов, выполните одно из следующих действий:

• Щелкните 

• Щелкните Actions > Hang up.

• Нажмите клавишу End.

Дополнительные ссылки
Обработка вызовов на стр. 23

Отправка текстовых сообщений
Об этой задаче
Вы можете отправить пользователю текстовое сообщение. Сообщение отображается на 
дисплее большинства телефонов Avaya. Эта функция не так сильно влияет на течение 
вызова, как прерывание. То, получит ли пользователь сообщение, зависит от типа телефона 
пользователя и от того, совершается ли в данный момент вызов.
По умолчанию максимальная длина сообщения составляет 16 символов, но ее может 
настроить администратор.
Если сообщение отправляется на телефон Avaya с цифровыми портами (DS), на телефоне 
включается индикатор сообщений. Это происходит независимо от того, совершается 
ли в данный момент вызов. Если телефон свободен, сообщение отображается. Если 
совершается вызов, сообщение отображается по его завершении.

Процедура
1. В справочнике найдите пользователя, которому хотите отправить сообщение.

Обработка вызовов
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2. Щелкните Actions > Send Message или нажмите клавиши Ctrl + M.

Поле внутреннего номера пользователя заполняется данными из справочника.

3. Введите текст в поле Message.

4. Щелкните OK.

Дополнительные ссылки
Обработка вызовов на стр. 23

Отправка мгновенных сообщений
Об этой задаче
В консоли можно настроить обмен мгновенными сообщениями. Если эта функция включена, 
можно отправлять мгновенные сообщения пользователям через справочник.
При этом другие пользователи должны использовать приложение Avaya, которое также 
поддерживает обмен мгновенными сообщениями.

Процедура
1. На панели Directory найдите нужного пользователя.

Отправка мгновенных сообщений
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2. Щелкните имя пользователя правой кнопкой и выберите Send Instant Message или 
нажмите клавиши Ctrl + I.

3. Введите сообщение в поле в нижней части окна и нажмите Send.

4. Вы можете переключаться между окном обмена мгновенными сообщениями и 
консолью, не прерывая их работы.

Если закрыть окно обмена мгновенными сообщениями, текущий сеанс чата будет 
завершен.

Дополнительные ссылки
Обработка вызовов на стр. 23

Отправка сообщений электронной почты
Если на вашем компьютере установлено приложение Microsoft Outlook, консоль можно 
использовать для отправки сообщений электронной почты пользователям из справочника.

Процедура
1. Щелкните Tools > Send Email или нажмите клавиши Ctrl+E.

Откроется форма сообщения электронной почты.

2. Введите необходимые сведения и отправьте сообщение обычным способом.

Дополнительные ссылки
Обработка вызовов на стр. 23

Обработка вызовов
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Выполнение пейджингового вызова
Об этой задаче
Вы можете отправить широковещательное сообщение группе пользователей, которым 
доступна функция пейджингового вызова. Например, вызывающему абоненту срочно 
необходимо поговорить с кем-то, но этот человек недоступен. Можно поставить вызов на 
ожидание, а затем отправить пользователю широковещательное сообщение с просьбой 
принять вызов. Пейджинговый вызов слышен на любом свободном внутреннем телефоне с 
динамиком громкой связи.

Процедура
1. Вот как отправить широковещательное сообщение:

• Щелкните .

• Щелкните Actions > Page.

• Нажмите клавишу F10.

2. Выберите группу, которой необходимо отправить широковещательное сообщение.

3. Щелкните OK.

4. Произнесите сообщение.

5. Затем выполните одно из следующих действий:

• Щелкните .

• Щелкните Actions > Hang up
• Нажмите клавишу End.

Дополнительные ссылки
Обработка вызовов на стр. 23

Выполнение пейджингового вызова
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Запись вызовов
Об этой задаче
Записать вызов можно полностью или частично.

• Запись поддерживается только на системах с установленным Voicemail Pro.
• Если вызов переводится в режим удержания или ожидания, запись 

приостанавливается. При повторном подключении вызова запись возобновляется.
• При добавлении пользователей к конференц-вызову запись продолжается.

Процедура
1. Чтобы записать вызов, выполните одно из следующих действий:

• Щелкните .

• Щелкните Actions > Record call.
• Нажмите клавишу F5.

По умолчанию запись разговора сохраняется в голосовой почте пользователя.

2. Чтобы прекратить запись, повторите одно из указанных выше действий.

Дополнительные ссылки
Обработка вызовов на стр. 23

Получение сообщений голосовой почты
Об этой задаче
Когда в почтовом ящике появляются новые сообщения, на это указывает строка состояния 
консоли.

Процедура
1. Дважды щелкните область, где показано количество сообщений, или нажмите 

клавиши Ctrl+V.

Будет выполнено подключение к серверу голосовой почты.

2. Если вы используете собственный внутренний номер, нажмите клавишу # или 
введите свой внутренний номер и нажмите #.

3. Введите пароль голосовой почты и нажмите клавишу #.

Войдя в почтовый ящик, вы услышите оповещение о полученных сообщениях.

Дополнительные ссылки
Обработка вызовов на стр. 23

Обработка вызовов
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Глава 4.  Перевод вызовов

Одной из главных функций консоли является перевод вызывающих абонентов в нужный 
пункт назначения.

Дополнительные ссылки
Передача вызова без ответа на него на стр. 35
Выполнение контролируемой передачи на стр. 36
Передача вызовов на голосовую почту на стр. 36
Wait for transfer to a busy extension на стр. 37

Making unsupervised transfers
An unsupervised transfer is one where you transfer the call without speaking to the transfer 
destination or wait to see if they answer.

Procedure
Use one of the following methods for transferring a call:

• Press F2. Select the transfer destination and click Dial (Alt+D).

• Click Actions > Transfer Call. Select the transfer destination and click Dial (Alt+D).

• Drag and drop the call onto the extension within the directory panel.

• Drag and drop the call onto the required BLF.

Передача вызова без ответа на него
Если вы узнали имя или номер вызывающего абонента, можно передать вызов, не отвечая 
на него. Такая передача вызова называется безусловной. В параметрах системы можно 
настроить возврат неотвеченных вызовов. Если вызов возвращен, на панели сведений о 
вызове указано (NoAns).

Процедура
1. Введите целевой внутренний номер в поле Search.
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2. Выберите нужное совпадение в результатах поиска и щелкните значок . Или, если 
в результатах поиска всего одно совпадение, щелкните .

Входящий вызов передается на целевой внутренний номер и исчезает с экрана.

Дополнительные ссылки
Перевод вызовов на стр. 35

Выполнение контролируемой передачи
Передача называется контролируемой, если перед передачей вызова вы консультируетесь с 
целевой стороной и проверяете, что вызов будет принят.

Процедура
1. Введите внутренний номер или имя пользователя в поле Search.

2. Если целевой внутренний номер свободен, щелкните значок  на панели 
справочника или нажмите клавишу F12. Будут слышны гудки исходящего вызова. 
Исходный вызов переводится в режим удержания.

• Если входящий вызов принимается для передачи, щелкните значок  или 
нажмите клавиши Ctrl+T, чтобы выполнить передачу.

• Если пользователь не готов принять вызов, щелкните  или нажмите клавишу 
End, чтобы завершить консультативный вызов. Вы можете вернуться к исходящему 
вызову, сняв его с удержания.

3. Если целевой внутренний номер занят, вы можете спросить вызывающего абонента, 
может ли он подождать. См. раздел «Ожидание передачи на занятый внутренний 
номер».

Дополнительные ссылки
Перевод вызовов на стр. 35

Передача вызовов на голосовую почту
Если вызывающий абонент хочет оставить сообщение, вы можете передать его на 
голосовую почту пользователя или группы.

Перевод вызовов
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Процедура
1. Нажмите клавишу F3 или щелкните Actions > Voicemail Transfer.

2. Выберите нужный справочник.

Можно также установить флажок напротив пунктов Show Hunt Groups и Show 
Users.

3. Начните вводить имя в поле Name.

4. Выберите Voicemail, когда внутренний номер появится в поле Number.

Вы также можете выбрать внутренний номер на панели справочника и нажать 
клавишу F3.

Дополнительные ссылки
Перевод вызовов на стр. 35

Wait for transfer to a busy extension
About this task
If the extension to which you want to transfer a call is shown as busy by the console, you can 
queue the call to wait for transfer when the extension becomes free. This avoids the transfer call 
being sent to voicemail or following the target's forward on busy setting.
This process parks the call on the system using the park ID of the target extension, that is, its 
extension number plus a single digit between 0 to 9.

Wait for transfer to a busy extension
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Procedure
1. If you haven’t already, answer the incoming call.

2. Ask if they would like to wait until the transfer target is no longer busy.

3. If they agree, press Ctrl + B. Their call is queued to wait until the transfer extension is 
free.

4. When the transfer extension becomes free, the call returns to the console with a yellow 
border. The text indicates why the call has returned. In the call details, scroll down to 
Reason:

Reason Description
Timeout If the call waits longer that the phone system's park timeout (the default is 

5 minutes), it recalls to you. Answer the call. If they still want to wait, press 
Ctrl + B to park the call again.

Free The transfer target is now able to take another call. Answer the call to do a 
normal supervised or unsupervised transfer or you can use Ctrl+R to do an 
immediate unsupervised transfer without answering the call.

Related links
Перевод вызовов on page 35

Перевод вызовов
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Глава 5.  Выполнение вызовов

Процедура
Совершить вызов можно одним из следующих способов:

• Наберите номер на телефоне.

• Дважды щелкните значок BLF для быстрого набора связанного номера.

• Найдите и выберите запись в справочнике и щелкните  или нажмите клавишу F12.

• Щелкните  или нажмите клавишу F12, чтобы отобразить экран выполнения вызова.

Дополнительные ссылки
Совершение вызова с помощью панели «Выполнение вызова» на стр. 40
Выполнение вызова с помощью панели набора номера на стр. 41
Использование значков BLF для быстрого набора на стр. 42
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Совершение вызова с помощью панели «Выполнение 
вызова»

Процедура

1. Щелкните значок  или нажмите клавишу F12.

2. Выберите справочник, в котором нужно выполнить поиск. Вы можете выбрать 
несколько справочников.

3. Начните вводить имя в поле Name.

Отобразятся записи, соответствующие введенному тексту. Когда в списке появится 
необходимый номер, щелкните его. Номер будет перенесен в поле Number. В случае 
только одного совпадения номер автоматически переносится в поле Number.

4. При необходимости введите сообщение метки вызова.

Выполнение вызовов
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5. Выберите требуемое действие:

Параметр Описание
Make call Поместите вызов на выбранный номер.
Voicemail Оставьте сообщение для пользователя.
Ringback Если внутренний номер занят, нажмите Ringback. Когда номер освободится, с 

него поступит обратный вызов.

Выполнение вызова с помощью панели набора номера
Процедура

1. Щелкните Tools > Dial pad или щелкните значок .

2. Введите нужный номер телефона в поле Number to Dial.

Используйте символы для набора на Dial pad или клавиатуру компьютера.

3. Введите примечания к вызову в поле Call Notes.

Примечания используются для текстовой метки вызова.

4. Щелкните Dial, чтобы выполнить вызов.

Выполнение вызова с помощью панели набора номера
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Использование значков BLF для быстрого набора
Процедура
Дважды щелкните нужный значок или щелкните его правой кнопкой и выберите Call.

Дополнительные ссылки
Выполнение вызовов на стр. 39

Выполнение вызовов
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Глава 6.  Конференции

В этом разделе описаны различные способы установки конференц-вызовов и управления 
ими.

Дополнительные ссылки
Добавление удерживаемых вызовов к конференции на стр. 43
Просмотр конференций на стр. 43
Добавление пользователей к конференции на стр. 44
Using the Conference Room Controls на стр. 44

Добавление удерживаемых вызовов к конференции
Об этой задаче
Вы можете поставить несколько вызовов на удержание, а затем создать с ними 
конференцию. Это удобно при спонтанных конференциях между тремя или четырьмя 
участниками. Если необходимо добавить больше участников, воспользуйтесь конференц-
залами.

Процедура
1. Начните несколько вызовов и поставьте каждый из них на удержание.

2. Нажмите кнопку .

3. Чтобы завершить конференц-вызов, щелкните .

Дополнительные ссылки
Конференции на стр. 43

Просмотр конференций
Об этой задаче
На панели справочника можно просматривать любые текущие конференции в телефонной 
системе. В списке отображаются специальные конференции, созданные другими 
пользователями, и конференции консоли.
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Процедура

Щелкните  на панели Directory.

Для конференций консоли указываются имя и инициатор конференции. Для других 
конференций указывается только их номер.

Дополнительные ссылки
Конференции на стр. 43

Добавление пользователей к конференции
Об этой задаче
Вы можете добавить вызов к любой конференции, проводимой в телефонной системе.

Процедура
1. Примите или совершите вызов пользователю.

2. Щелкните  на панели Directory, чтобы отобразить список текущих конференций.

3. Выберите нужную конференцию.

4. Щелкните Actions > Add to Conference.

Дополнительные ссылки
Конференции на стр. 43

Using the Conference Room Controls
The  and  buttons in the main toolbar represent the two conference rooms. You can use the 
conference rooms to start conferences with multiple participants.

Note: The buttons are not available until the conference room names have been created. See 
Naming conference rooms on page 67.

Conference participants are represented by the following icons:

Not invited Invited Joined Declined Unavailable

Related links
Конференции on page 43
Использование конференц-зала on page 45

Конференции
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Изменение вида конференц-зала on page 46
Изменение расположения значков комнаты для конференц-связи on page 47
Изменение состояния пользователя on page 47

Использование конференц-зала
Об этой задаче
Кнопки  и  на главной панели инструментов представляют два конференц-зала. Эти 
залы можно использовать для проведения конференций с несколькими участниками.
Если кнопки конференц-связи доступны, вы можете создать конференцию. Если кнопки 
недоступны, это значит, что конференц-залам не назначены имена. См. раздел Naming 
conference rooms на стр. 67.

Процедура

1. Нажмите кнопку  или .

Если конференц-зал используется, значки BLF в окне показывают состояние 
делегата. Если зал не используется, отображается пустое окно.

2. Чтобы создать конференцию, в поле Conference Description введите тему 
конференции.

Тема отображается только в этом поле.

3. В поле Conference Host введите имя пользователя, запросившего конференцию.

Using the Conference Room Controls
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Имя отображается при просмотре текущих конференций в системе на панели 
справочника.

4. Укажите участников конференции.

a. Щелкните Add Users.

b. Выберите пользователей в списке справочника.

c. Если вы добавили пользователя по ошибке, щелкните правой кнопкой значок 
BLF пользователя и выберите Remove.

5. Пригласить пользователей в конференцию можно одним из следующих способов:

• Автоматическое приглашение. Для автоматического приглашения пользователей 
с помощью системы голосовой почты нажмите Invite Users. Значки BLF 
выделяются желтой рамкой. Каждый пользователь получает пригласительный 
вызов. Сервер голосовой почты приглашает пользователей группами до 
5 человек в зависимости от доступных подключений. Ответившие пользователи 
приглашаются в конференцию. Значки конференции автоматически меняются, 
указывая на ответ пользователя. Пользователь может ответить одним из 
следующих способов:

Этот вариант доступен только в системах с Voicemail Pro.

- нажав 1, чтобы принять приглашение;

- нажав 2, чтобы отклонить приглашение;

- нажав 3, чтобы сообщить о недоступности.

• Приглашение вручную. Чтобы пригласить пользователей вручную, щелкните 
правой кнопкой имя каждого пользователя и выберите Call.

- Если пользователь принял приглашение, нажмите Add to conference 1 или Add 
to conference 2 в меню Действия.

- Если пользователь недоступен или отклонил приглашение и вызов, щелкните 
правой кнопкой значок BLF, чтобы изменить состояние пользователя 
соответственно и записать ответ делегата.

6. Во время конференции можно добавить дополнительных пользователей с помощью 
команды Add to conference 1 или Add to conference 2.

Вы можете добавить пользователя в комнату для конференц-связи, перетащив его 
значок BLF в окно конференции. Можно использовать значки BLF, представляющие 
как внутренние, так и внешние номера.

Дополнительные ссылки
Using the Conference Room Controls на стр. 44

Изменение вида конференц-зала
Процедура

1. Щелкните правой кнопкой окно Конференц-зал.

Конференции
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2. Во всплывающем окне выберите View.

Доступные виды:

• Крупные значки

• Мелкие значки

• Список значков

• Сведения

Дополнительные ссылки
Using the Conference Room Controls на стр. 44

Изменение расположения значков комнаты для конференц-
связи

Процедура
1. Щелкните правой кнопкой в окне Комната для конференц-связи.

2. Во всплывающем окне выберите Arrange.

Доступные варианты:

• Имя

• Номер

• Состояние

Дополнительные ссылки
Using the Conference Room Controls на стр. 44

Изменение состояния пользователя
Процедура

1. Щелкните правой кнопкой панель BLF пользователя.

2. Выберите Change Status.

3. Выберите нужное состояние.

Дополнительные ссылки
Using the Conference Room Controls на стр. 44

Using the Conference Room Controls
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Глава 7.  Использование справочника

В справочнике показаны контакты для вызовов.

Дополнительные ссылки
Using the Directory на стр. 48
Изменение свойств записи справочника на стр. 50
Добавление и изменение записей локального справочника на стр. 52
Изменение состояния групп схожих операторов на стр. 53
Изменение состояние пользователя на стр. 54

Using the Directory
The console panel on the right usually displays the directory of telephone names and numbers. It 
can include the directory entries from the telephone system, the console's own local directory and 
contacts from Outlook.

Changes to the telephone system directory are updated automatically every 30 minutes. They 
are also updated when make a manual search using the directory (up to a maximum of every 5 
minutes).

Directory Controls
You can use these controls to select what information is displayed in the directory panel.

Call the selected entry: Make a call to the selected directory entry.

Table continues…
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Edit the selected entry: Edit the properties of the directory entry. The settings menu displayed 
depends on the type of entry.
View directory items: Switch between viewing details of a selected contact/conferences/other 
information and viewing the directory.
View active conferences: Use the directory panel to view conferences being hosted by the 
telephone system.
Show/hide users: Show or hide telephone system users in the displayed list of directory 
contacts.
Show/hide groups: Show or hide telephone system groups in the displayed list of directory 
contacts.
Show/hide directory contacts: Show or hide other contacts in the displayed list of directory 
contacts.

Directory Icons
These icons indicate the type each contact shown in the directory.

User: A user on the telephone system.

Hunt Group: A hunt group on the telephone system.

Directory: A directory entry from the telephone system directory or the console’s local 
directory.
Outlook Contact: A contact from Microsoft Outlook running on the same PC as the console.

Directory Entry Details
When the search has only one remaining match or when you double-click on a particular entry, 
the directory changes to show details for that entry. The information to display can be configured 
through the console settings.
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To return to the full directory listing, remove the text from the search box. Alternatively, select 
Directory > New Search (Ctrl + S).

Related links
Использование справочника on page 48

Изменение свойств записи справочника
Об этой задаче
В окне Свойства записи справочника можно изменить свойства выбранной записи.
Все записи справочника имеют свой значок, который указывает на тип записи.

•  обозначает пользователя.

•  обозначает запись справочника.

•  обозначает группу схожих операторов.

Примечание:
На консоли отображаются настройки, заданные на момент выбора пользователя или 
группы. Если настройки затем изменяются другим способом, например с телефона 
пользователя, эти изменения отобразятся только после закрытия и повторного открытия 
консоли.

Процедура
1. Щелкните запись в справочнике.
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2. Щелкните .

3. Дважды щелкните запись справочника, чтобы просмотреть свойства на панели.

4. Дважды щелкните свойство, чтобы посмотреть подробности. Тип формы зависит 
от того, находится номер в справочнике телефонной системы или локальном 
справочнике консоли.

• В форме Directory Entry Properties отображаются имена и номера из телефонной 
системы. Они используются для исходящего набора номеров и сопоставления 
имен с номерами входящих вызовов. Получить доступ к записям справочника 
телефонной системы могут все пользователи с помощью соответствующих 
функций на своих телефонах. Для номера из справочника телефонной системы 
используются только поля Name и Phone Number. Значения в этих полях 
невозможно изменить с помощью консоли.

• В окне Edit IP Office SoftConsole Local Directory Entry показан локальный 
справочник консоли, используемый для исходящего набора номеров и 
сопоставления имен с номерами входящих вызовов. Если имя присутствует как 
в справочнике телефонной системы, так и в локальном справочнике консоли, 
используется имя из справочника консоли.
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Дополнительные ссылки
Использование справочника на стр. 48

Добавление и изменение записей локального 
справочника

Об этой задаче
На вкладке Incoming Calls можно создавать записи и изменять свойства существующих 
записей локального справочника.

Процедура

1. Щелкните .

2. Откройте вкладку Incoming Calls или выберите Tools > Preferences > Incoming 
Calls.

3. Чтобы добавить новую запись, нажмите Add.

4. Чтобы изменить существующую запись, выберите запись и нажмите Edit.
5. В поле Name введите или измените имя, которое хотите связать с записью.

6. В поле Number введите номер телефона, который будет набран при выборе записи в 
справочнике. Этот номер также будет сопоставляться с номерами входящих вызовов.

7. В поле Script File введите или выберите имя файла сценария (.txt или .rtf), 
которое будет связано с записью в справочнике. Если номер входящего вызова 
совпадет с номером в справочнике, сценарий отобразится на панели справочника.
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8. В поле Media File введите или выберите имя медиафайла (.wav), которое будет 
связано с записью в справочнике. Если номер входящего вызова совпадет с номером 
в справочнике, файл будет воспроизводиться компьютером консоли.

Дополнительные ссылки
Использование справочника на стр. 48

Изменение состояния групп схожих операторов
Об этой задаче
Для группы схожих операторов можно задать два состояния: In Service и Out of Service.

Примечание:
На консоли отображаются настройки, заданные на момент выбора пользователя или 
группы. Если настройки затем изменяются другим способом, например с телефона 
пользователя, эти изменения отобразятся только после закрытия и повторного открытия 
консоли.

Процедура

1. Щелкните  на панели Справочник.

2. Щелкните .

Состояние группы схожих операторов можно изменить в зависимости от настроек 
телефонной системы. Если группа поиска находится в состоянии Out of Service, 
вызовы переводятся на другой номер или на голосовую почту. Возможность 
использовать эту функцию по умолчанию отключена. Третий вариант состояния — 
Night Service — устанавливается либо автоматически в зависимости от настроек 
времени, либо путем использования специального режима набора номера.
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Дополнительные ссылки
Использование справочника на стр. 48

Изменение состояние пользователя
Вы можете изменить состояние пользователя в справочнике.

Процедура

1. Щелкните  на панели Directory.

2. Щелкните .

3. Для пользователя можно изменить следующие параметры:

Параметр Описание
Do Not Disturb Показывает, находится ли пользователь в состоянии «Не 

беспокоить».
Bar Outgoing Calls Пользователь не может совершать исходящие вызовы.
Forwarding Показывает настройки переадресации.
Group Service Status Список групп схожих операторов, в которых состоит 

пользователь. Если напротив группы установлен флажок, 
пользователь состоит в ней.

Использование справочника
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Дополнительные ссылки
Использование справочника на стр. 48
Изменение статуса переадресации пользователя на стр. 55
Настройка мобильного дублирования на стр. 57
Follow Me behavior на стр. 58
Forward Unconditional behavior на стр. 59
Forward on Busy/No Answer behavior на стр. 59

Изменение статуса переадресации пользователя
Об этой задаче
Вы можете просматривать и изменять статус переадресации пользователя. Входящие 
вызовы можно перенаправлять на номер внутреннего или внешнего телефона. Введите 
целевой номер телефона и выберите переадресацию для всех или только внешних 
вызовов.
Существуют четыре типа переадресации:

• Следуй за мной
• Безусловная переадресация
• Переадресация при занятости
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• Переадресация при отсутствии ответа
Если используются кнопки представлений вызовов, параметр «Переадресация при 
занятости» применяется, только если все эти кнопки заняты.
Введите целевой номер телефона и выберите переадресацию для всех или только внешних 
вызовов.

Примечание:
На консоли отображаются настройки, заданные на момент выбора пользователя или 
группы. Если настройки затем изменяются другим способом, например с телефона 
пользователя, эти изменения отобразятся только после закрытия и повторного открытия 
консоли.

Процедура

1. Щелкните  на панели Directory.

2. Щелкните .

3. Щелкните Forwarding.

4. Введите целевые номера телефонов в соответствующих полях.

Вы можете выбрать номера из списка в справочнике. Введите внутренний номер 
в качестве целевого назначения для режима «Следуй за мной». Для некоторых 
параметров переадресации требуется настройка системы телефона. Например, 
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пользователю может быть запрещено совершать исходящие вызовы. Для получения 
дополнительных сведений обратитесь к системному администратору.

5. Щелкните правой кнопкой мыши в поле номера.

6. Выберите нужный номер из списка.

7. Щелкните Add.

Дополнительные ссылки
Изменение состояние пользователя на стр. 54

Настройка мобильного дублирования
Если в системе включено дублирование, все входящие вызовы поступают на внутренний 
номер и внешний дублированный номер. Например, вызов поступает на внутренний 
номер и на мобильный телефон пользователя. Его можно принять как с внутреннего, 
так и с мобильного телефона. Обратитесь к системному администратору. Мобильное 
дублирование — это лицензированная функция.

Об этой задаче
Если выбраны функции переадресации, будут звонить и внутренний, и внешний телефон, на 
который переадресовываются вызовы.
Если используются коды учетной записи, пользователь не может ввести код, отвечая на 
вызов на внешнем телефоне.
Если выбрана функция Do Not Disturb , абоненты, выполняющие вызов на внутренний 
номер, будут слышать сигнал «Занято». Внешний телефон пользователя звонить не будет. 
Если вызывающий абонент внесен в список исключений для состояния «Не беспокоить», 
звонит только внутренний телефон. Пользователи не могут добавлять номера в этот список. 
Обратитесь к системному администратору.
Если выбран параметр Follow Me , будет звонить только внутренний телефон, на который 
переадресовываются вызовы. Внешний телефон звонить не будет.
Если настройки изменяются другим способом, например с помощью другого приложения 
или через телефон пользователя, указанные в консоли значения не обновляются 
автоматически. Значения, указанные в каталоге консоли, были установлены на момент 
выбора пользователя или группы.

Процедура

1. Щелкните  на панели Directory.

2. Щелкните .

3. Щелкните Forwarding.

4. Выберите Mobile Twinning.

5. В поле Mobile Twinning введите номер телефона, который будет дублировать 
внутренний номер пользователя. Номер телефона вводится без пробелов.

6. Щелкните OK, чтобы сохранить изменения.

Изменение состояние пользователя

March 2024 Using IP Office SoftConsole 57
Комментарии к документу? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=UsingIPOfficeSoftConsole&p3=10


Дополнительные ссылки
Изменение состояние пользователя на стр. 54

Follow Me behavior
When you select Follow Me forwarding, the system forwards all calls to the designated extension 
number. Use this feature to temporarily redirect calls when you are away from your extension but 
available at another extension. You must enter an internal extension number as the destination.

Follow Me works in the following ways:

• You can make calls from your original extension. The only calls that can be received at your 
original extension are calls made from the Follow Me destination extension.

• Any Speed Dial associated with your original extension number does not indicate that the 
calls are being forwarded to another number.

• If you have set an absent message, the text is displayed to callers. If absent text is active 
at the destination extension, it will not be displayed because your absent message takes 
priority.

Forwarding settings affect Follow Me behavior
The following Forwarding options affect how Follow Me works:

Forward 
Unconditional

Setting is ignored.

Forward on Busy If the destination extension is busy, the call is forwarded to your Forward on Busy 
destination. If there is no answer at the extension, the call is transferred to your 
voicemail, if available.

Forward on No 
Answer

If there is no answer at the destination extension, the Forward on No Answer setting is 
ignored and the call is transferred to your voicemail, if available.

Scenarios
Anne Webb (extension 206) diverts all her calls to extension 207 using Follow Me. There is an 
incoming call for Anne. Depending on what happens at extension 207, the following behavior will 
occur:

Scenario Forward on Busy/No Answer No Forward
Extension 207 is 
busy.

Call is transferred to Anne’s Forward on 
Busy extension number.

Call is transferred to Anne’s voicemail.

No answer at 
extension 207.

Call is transferred to Anne’s voicemail. Call is transferred to Anne’s voicemail.

Related links
Изменение состояние пользователя on page 54
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Forward Unconditional behavior
When you select Forward Unconditional and enter a destination number entered, the system 
redirects all your calls to an extension number or, if enabled, an external number. See your system 
administrator to determine if you can forward to an external number.

Forward Unconditional works in the following ways:

• You can make outgoing calls from your extension. The only calls that you can receive when 
all your calls are forwarded are calls made from the destination number.

• If you have set an absent message, the text is displayed to caller. If absent text is active at 
the destination extension it will not be displayed because your absent message takes priority.

Forwarding settings affect Forward Unconditional behavior
The following Forwarding options affect how Forward Unconditional works:

Follow Me Overrides Forward Unconditional setting.
Forward Hunt 
Group Calls

Only applies to hunt groups that are configured for sequential or rotary ringing mode. See 
your system administrator. It includes internal calls to the hunt group regardless of the 
Forward Internal Calls setting.

Forward on Busy Not available.
Forward on No 
Answer

Not available.

Scenarios
Forward 

Unconditional
Forward Hunt 
Group Calls

Forward 
Incoming Calls

Behavior

Yes Yes Yes All calls redirected to the Forward Unconditional 
destination number.

Yes Yes No External calls and hunt group calls received by your 
extension are redirected to the Forward Unconditional 
destination number.

Yes No No External calls are redirected to the destination number. 
Internal calls, including any hunt group calls, are 
presented to your extension.

Related links
Изменение состояние пользователя on page 54

Forward on Busy/No Answer behavior
When you select Forward on Busy/No Answer, your calls are redirected to the number entered in 
the Forward on Busy/No Answer field. The same number is used for calls forwarded when your 
extension is busy or not answered.
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Forward on Busy/No Answer works in the following ways:

• The first time you select Forward on No Answer, the option Forward Internal Calls is 
automatically selected. If Forward Internal Calls and Forward on No Answer are de-selected, 
the next time Forward On No Answer is selected, the option Forward Internal Calls is not 
automatically selected.

• If you have set an absent message, the text is displayed to callers when the Forward on 
Busy/No Answer forwarding option is selected. If absent text is active at the destination 
extension it will not be displayed because your absent text takes priority.

Scenarios
Forward on 

Busy
Forward on No 

Answer
Forward 

Internal Calls
Behavior

Yes – – External calls are forwarded to the specified number 
when your extension is busy. Internal calls are 
transferred to your voicemail, if available.

Yes – Yes All calls are forwarded to the specified number 
when your extension is busy.

– Yes – External calls are forwarded to the specified number 
when your extension is not answered. Internal calls 
are transferred to your voicemail, if available.

– Yes Yes All calls are forwarded to the specified number 
when your extension is not answered.

Yes Yes – External calls are forwarded to the specified number 
when your extension is not answered or your 
extension is busy. Internal calls are transferred to 
your voicemail, if available.

Yes Yes Yes All calls are forwarded to the specified number 
when your extension is not answered or is busy.

Related links
Изменение состояние пользователя on page 54
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Глава 8.  Использование истории 
вызовов

В этом разделе рассматривается использование представления истории вызовов на консоли. 
История вызовов хранится на локальном компьютере, на котором запускается приложение. 
Поэтому история отличается от журнала вызовов, хранящегося на телефоне, который вы 
используете вместе с консолью.

Следует учесть, что сведения о вызове автоматически удаляются из истории вызовов через 
определенное количество дней. См. раздел General console settings на стр. 78.

Дополнительные ссылки
Просмотр журнала вызовов на стр. 61
Выполнение вызова с панели журнала вызовов на стр. 61
Очистка истории вызовов на стр. 62

Просмотр журнала вызовов
Процедура
Щелкните View > History.

Данные Call History заменяют панели BLF и «Вызовы на удержании».

Дополнительные ссылки
Использование истории вызовов на стр. 61

Выполнение вызова с панели журнала вызовов
Процедура
Дважды щелкните номер телефона, указанный в журнале вызовов.

Дополнительные ссылки
Использование истории вызовов на стр. 61
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Очистка истории вызовов
Об этой задаче
Сведения о вызове автоматически удаляются из истории вызовов через определенное 
количество дней. Этот период устанавливается с помощью настройки Call history retention 
period (in days) на консоли, см. раздел General console settings на стр. 78.
Однако при необходимости вы можете вручную удалить вызовы с одной или со всех 
вкладок. Для этого сделайте следующее:

Процедура
1. Щелкните историю вызовов правой кнопкой.

2. Чтобы удалить все вызовы с текущей вкладки, выберите Clear.
3. Чтобы удалить все вызовы со всех вкладок, выберите Clear All Tabs.

Дополнительные ссылки
Использование истории вызовов на стр. 61
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March 2024 Using IP Office SoftConsole 62
Комментарии к документу? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=UsingIPOfficeSoftConsole&p3=10


Глава 9.  Настройка приложения консоли

В этом разделе описаны различные элементы управления для настройки внешнего вида и 
работы приложения.

Console settings
You can configure or edit console settings by clicking  Preferences and then selecting the 
appropriate tabs.

Tab Description
Appearance Change the general appearance of the console application. For example, you can 

change font and colors used to indicate call status.
BLF groups Create, edit, and delete Busy Lamp Field (BLF) groups. You can also rearrange the 

order of the groups.
Conferencing Specify the names of conference rooms.
Directories Specify whether directory information is included in the directory display or in the 

properties of individual entries.
Door Entry Specify door names. You cannot control doors in console until you enter door 

names.
Incoming Calls Optionally, provide a name match against an incoming call. You can use matching 

numbers to play a specific script or media file on calls.
Keyboard actions Customize the default actions performed when you start typing text or a number.
Keyboard 
mapping

View and change keyboard shortcuts.

Park Slot Specify the available slot buttons and the IDs associated with each button.
Queue mode Configure and monitor up to eight hunt group queues.
SoftConsole Configure how the console saves changes you make to the screen layout. You can 

also specify the console behavior when you close its window.
Instant Messaging Configure support for instant messaging.

March 2024 Using IP Office SoftConsole 63
Комментарии к документу? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=UsingIPOfficeSoftConsole&p3=10


Customizing the console’s appearance
About this task
You can change the general appearance of the console application. For example, you can change 
font and colors used to indicate call status.

Before you begin
If you want to use a custom skin, you must have a skin definition file.

Procedure
1. Щелкните  Preferences.

2. Select Appearance.

3. (Optional) Select a new font from the Font drop-down menu.

4. (Optional) If you want to select and use a custom skin, select the Apply Custom Skin 
check box.

A skin is a set of files defining the whole appearance of the application. By default, no 
additional skins are supplied.

Click Browse and upload your skin definition file.

5. (Optional) Change the call status colors.

Настройка приложения консоли
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You can select a different color for each call status. These colors appear in the border of 
the call details panel. The available call status options are:

• Idle
• Alerting - Incoming
• Alerting - Outgoing
• Connected
• Return Call

Working with BLF groups
About this task
Busy Lamp Field (BLF) icons provide user status and speed dials at a glance. You can add icons 
for other numbers, which act as speed dials. You can also group BLF icons to appear on different 
named tabs.

Procedure
1. Щелкните  Preferences.

2. Select BLF groups.

The menu displays the name of each group and the members within the group.

3. To create a new BLF group:

a. Click New.

You can also right-click on a blank area of the BLF panel and then select New > BLF 
groups.

b. Enter a unique name in BLF Group Name.

c. Select the required members from the Members not in BLF Group list.

You can press Ctrl on your keyboard to select multiple members at a time.

Working with BLF groups
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d. Click Add to add the selected members.

e. Щелкните OK, чтобы сохранить изменения.

The new BLF group appears at the end of the list.

4. To edit the selected BLF group:

a. Click Edit.
b. Add or remove group members as required.

c. Щелкните OK, чтобы сохранить изменения.

5. To delete the selected BLF group, click Delete.

6. To change the position of BLF groups in the list:

a. Select the group you want to move.

b. Click Move Up and Move Down as required.

Изменение вида панели BLF
Процедура

1. Щелкните панель BLF правой кнопкой и выберите View.

2. Выберите вид.

Выбор Описание
Ctrl + Alt + G Крупные значки

Ctrl + Alt + S Мелкие значки

Ctrl + Alt + I Список значков

Ctrl + Alt + D Сведения

3. Чтобы изменить расположение значков, щелкните панель BLF правой кнопкой и 
выберите Arrange.

4. Выберите способ расположения значков.

Выбор Описание
Ctrl + Alt + N Порядок по имени

Ctrl + Alt + M Порядок по номеру

Ctrl + Alt + U Порядок по состоянию

5. Чтобы мелкие или крупные значки сообщений располагались по горизонтали, 
нажмите Ctrl + Alt + H.

6. Чтобы мелкие или крупные значки сообщений располагались по вертикали, нажмите 
Ctrl + Alt + V.

Настройка приложения консоли
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Adding members to a BLF group
About this task
You can add members to a BLF group from the BLF panel in the main window.

Procedure
1. To add new members to a BLF group, do one of the following actions:

• Right-click within the BLF panel, highlight New and click BLF Group Member.
• Press Ctrl + Alt + B.

• Double-click within the BLF panel.

2. Enter the Name and Number for the new member.

3. Click OK to return to the BLF panel.

Naming conference rooms
About this task
Name the two conference rooms that console supports. The names appear on the telephone 
displays of internal users in the conference room.

Important:
The conference room features cannot be used until the rooms are given names.

Naming conference rooms
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Procedure
1. Щелкните  Preferences.

2. Select Conferencing
3. Enter unique names for each conference room.

Each name can contain up to 10 characters.

Настройка приложения консоли
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Configuring the Directories Display

Directory access
The options that appear in this section show where directory numbers, other than users and 
groups, are obtained.

Name of option Description
IP Office SoftConsole 
Local Directory

Show directory entries stored locally by the console application.

IP Office Directory Show system directory entries stored on the telephone system.
Microsoft Outlook 
Contacts Folder

This options allows address book entries from Outlook to be included in the 
directory.

• Outlook must be running on the same computer.

• You must run Outlook with administrator privileges.

Directory fields for search results
When a directory search matches an individual directory entry, the directory panel displays 
information about the entry.

Configuring the Directories Display

March 2024 Using IP Office SoftConsole 69
Комментарии к документу? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=UsingIPOfficeSoftConsole&p3=10


Configuring the Console’s Locale Directory Entries
On the Incoming Calls tab, you can setup directory names and numbers shown in the Directory 
panel as the console’s local directory. The directory numbers can be used to make outgoing calls 
and provide a name match for incoming calls.

You can associate a specific script to display or a media file to be played when the console 
receives a call from a matching number. For default call handling, you can set a default script or 
default sound file. These settings apply when the incoming call does not match a specific number 
that has its own script or sound file assigned.

IP Office SoftConsole Local Directory: 
This table displays the local directory of contacts stored by the console application.

Field name Description
Name The contact name.
Number The telephone number that is dialed when the directory entry is selected. This 

number is also used for matching against incoming calls.
Script File A script can be associated with the directory entry. When an incoming call matches 

the directory number, the script is displayed in the directory panel. The script can be 
a .TXT or .RTF file.

Media File A sound file can be associated with the directory entry. When an incoming call 
matches the directory number, the file is played by the console PC. The file is 
a .WAV file.

Настройка приложения консоли
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Button Description
New Add a new directory entry.
Edit Edit the selected entry.
Delete Delete the selected entry.
Open Directory 
File

Change the file used for storing the console’s local directory entries. The entries in 
the selected file are then listed in the window.

Default Call Handling: 
These fields can be used to associate a script file and or media file with any calls that do not have 
its own script and or media file specified in the directory.

Field name Description
Script File A script can be associated with the directory entry. When an incoming call matches 

the directory number, the script is displayed in the directory panel. The script can be 
a.TXT or .RTF file.

Media File A sound file can be associated with the directory entry. When an incoming call 
matches the directory number, the file is played by the console PC. The file is 
a .WAV file.

Entering door names
About this task
You must enter door names before you can use the console to control a door attached to the 
telephone system.

Entering door names
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Procedure
1. Щелкните  Preferences.

2. Select Door Entry.

3. In Name, type the name that you want to use for the door.

For example, you might enter the name Loading Bay for a door to a loading bay.

The Entry Code for each door name is pre-populated with 1 or 2. The number indicates 
the door relay to activate. You cannot change entry codes.

4. Щелкните OK, чтобы сохранить изменения.

Result
You can now open a door from Tools > Door Entry. You can then select the appropriate door 
name from the menu.

Configuring keyboard actions
About this task
You can specify what happens in the console when you start pressing alphabetic or numeric 
keyboard characters.

Before you begin
If you want to modify the Maximum length for call notes field, you must log in to the console in 
Administrator mode.

Procedure
1. Щелкните  Preferences.

Настройка приложения консоли
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2. Select Keyboard actions.

3. Select the appropriate default action for alphabetic keystrokes. The options are:

• Begin Directory Search
• Open Call Annotation Window

4. Select the appropriate default action numeric keystrokes. The options are:

• Begin Directory Search
• Open Pop-up Dial Pad

5. (Optional) If you are in Administrator mode, modify Maximum length for call notes if 
required.

The default length is 16 characters. If you increase this value, the note might not be fully 
visible on all telephones and applications. The length specified in this field also applies to 
text messages that you send to other users’ phones.

Modifying keyboard shortcuts
About this task
You can view and modify the console keyboard shortcuts.

Procedure
1. Щелкните  Preferences.

2. Select Keyboard mapping.

3. From the Category drop-down menu, select the set of shortcuts that you want to view.

Modifying keyboard shortcuts
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4. To modify a specific shortcut key:

a. Select the current shortcut key.

b. Use the drop-down menu to select a new shortcut key.

A warning displays if the new shortcut key you select is already in use.

5. To reset all shortcut keys back to their default settings, click Reset all.

Configuring park slots
About this task
You can set the number of available Park Slot buttons and the IDs associated with each button.

Procedure
1. Щелкните  Preferences.

2. Select Park slots.

3. To add or edit a park slot:

a. Click New to add a new park slot.

b. Click Edit to modify the selected park slot.

c. Enter or modify the alphanumeric park slot ID, which can contain letters and numbers, 
but not spaces.

Настройка приложения консоли
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Note:

If you need a secure parking slot, configure the park slot ID with text. You will not 
be able to unpark the call using normal telephone dialing. Instead, you will need to 
use an application Park Slot button set to the same text.

d. Enter a keyboard shortcut to park or unpark a call into a specific park slot. You can 
also use the Keyboard mapping tab to edit shortcuts.

4. To remove the selected park slot from the list, click Delete.

5. To change the order of configured park slots:

a. Select the park slot you want to move.

b. Click Move Up and Move Down as required.

Configuring park slots
About this task
You can set the number of available Park Slot buttons and the IDs associated with each button.

Procedure
1. Щелкните  Preferences.

2. Select Park slots.

a. Click New to add a new park slot.

b. Click Edit to modify the selected park slot.

3. Configure the park slot as required:

Choice 
Option

Choice Description

Park Slot ID Each ID can be alphanumeric, containing both numbers and letters. The ID 
should not include spaces.

Note:

If you need a secure parking slot, configure the park slot ID with text. You will 
not be able to unpark the call using normal telephone dialing. Instead, you 
will need to use an application Park Slot button set to the same text.

Configuring park slots
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Choice 
Option

Choice Description

Shortcut A keyboard short cut that enables the operator to park or unpark a call into 
a specific park slot. The short cuts can also be edited through the Keyboard 
Mappings menu

4. Click OK.

Configuring queue monitoring for hunt groups
About this task
You can configure queue monitoring for a specific hunt group. You can configure and monitor up 
to eight queues. One of the queues is configured as a recall queue. The recall queue shows calls 
that have been queued, answered, and then transferred. In this case, the transferred call was not 
answered. Instead of being returned to the original queue, these types of calls are placed into a 
new queue called “Recall”.

Before you begin
An administrator must configure a hunt group on the telephone system with queuing enabled.

Procedure
1. Щелкните  Preferences.

2. Select Queue mode.
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Details of queues being monitored display on the screen. You can see the alarm thresholds 
for each queue. The alarm thresholds are the number of calls and the longest waiting call.

3. To add or edit a queue:

a. Click New to add a new queue to monitor.

b. Click Edit to modify the settings of the selected queue.

c. Select the appropriate queue type from the Queue Name drop-down menu.

d. Select the shortcut key combination for the queue from the Shortcut drop-down 
menu.

e. Select the appropriate alarm settings for the queue.

For more information about alarm settings, see Alarm setting field descriptions on 
page 78.

4. To delete the selected queue, click Delete.

5. To adjust the order of queues in the display:

a. Select the queue you want to move.

b. Click Move Up and Move Down as required.

6. (Optional) In the Color preferences section, change the colors that the queue uses for 
normal conditions and alarm conditions.

7. (Optional) Configure alarm handling to define what happens when a queue goes over the 
alarm threshold.

You can select one of the following alarm handling options:

• Automatically restore IP Office SoftConsole
• Ask me whether to restore IP Office SoftConsole
• Ignore the alarm

Configuring queue monitoring for hunt groups
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Alarm setting field descriptions

When creating or editing a queue, you can configure the alarm settings described in the following 
table.

Name Description
Number of Calls 
In Queue

When this check box is selected, an alarm occurs when the number of calls within 
the queue reaches the number specified.

You can modify the number of calls within the queue before an alarm occurs.
Longest Waiting 
Time

When this check box is selected, an alarm occurs when the call wait time in seconds 
reaches the time specified.

You can modify the call wait within the queue in seconds before an alarm occurs.
Play Media File You can upload an audio file that defines how the alarm sounds. The alarm goes off 

when a defined alarm state is reached.

General console settings
About this task
You can define how profile changes are saved. You can also set how the console behaves for 
incoming calls and when its window is closed.

Настройка приложения консоли
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Procedure
1. Щелкните  Preferences.

2. Select SoftConsole.

Option Description
General
Pop 
SoftConsole

If selected, the console is brought to the front of all applications running on the 
PC running when you receive a new incoming call.

Hide on Close If selected, closing the console minimizes it to the system tray in your 
Windows task bar. You can exit the application by selecting  in the system 
tray and then clicking Exit.

Auto directory 
refresh

If selected, the console updates the directory contacts from the telephone 
system every 30 minutes and every time a directory search is performed.

If not selected, the contacts are only updated each time the console is started.
Save Options
Automatically 
save changes to 
my profile

If selected, when you close the console, any changes to your console settings 
are automatically saved to the profile that was selected when logging in.

Prompt me to 
save changes to 
my profile

If selected, when you close the console, you are prompted whether to save 
changes to your console settings to the profile that was selected when logging 
in.

Call History Retention
Call history 
retention period 
(in days)

This value sets how long details of a call remain in the console’s call history 
before being automatically deleted.

3. Щелкните OK, чтобы сохранить изменения.

General console settings
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Enabling instant messaging
About this task
Before you complete this configuration, the console status bar displays IM disconnected.

Procedure
1. Щелкните  Preferences.

2. Select Instant Messaging.

3. Select Enable instant messaging if you want to use IM with the console.

4. Щелкните OK, чтобы сохранить изменения.
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Глава 10.  Шаблоны и профили

При первом входе в систему вы выбираете один из шаблонов консоли по умолчанию. 
Используя консоль, вы можете изменять различные настройки, а также внешний вид 
экрана. Эти изменения можно сохранить в виде личного профиля. Текущий профиль или 
используемый шаблон показан в строке состояния консоли.

Примечание:

Чтобы иметь возможность скрыть или показать панели Вызовы на удержании и BLF, 
необходимо войти в консоль в качестве администратора.

Загрузка и сохранение профиля
Об этой задаче
При входе в систему можно загрузить новый профиль. Вы можете сохранять изменения 
профиля вручную или настроить консоль на автоматическое сохранение при каждом 
изменении.

• Чтобы загрузить профиль при входе, выполните одно из следующих действий:

1. Щелкните Expand.

2. Выберите необходимый профиль.

• Чтобы вручную сохранить изменения текущего профиля, выберите File > Save Profile.

• Вот как вручную сохранить изменения нового профиля:

1. Выберите File > Save Profile As.

2. Введите новое имя файла.

3. Щелкните OK, чтобы сохранить изменения.

В строке состояния отображается имя нового профиля.

• Чтобы настроить консоль на автоматическое сохранение, выберите  Preferences > 
SoftConsole.
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Editing a profile
Before you begin

• You must be in Administrator mode. See Logging into administrator mode on page 84.
• Ensure you select the profile you want to edit when you are logging in.

Procedure
1. Make the required changes in the profile.

• In View, you can hide or show the Busy Lamp Fields (BLF), Held calls, and Park slots 
panels. You can also access the normal view options.

2. Click File > Save Profile to save your changes.

Создание шаблона
Об этой задаче
Профиль пользователя можно создать с помощью шаблонов.

Предварительные требования
• You must be in Administrator mode. See Logging into administrator mode на стр. 84.

Процедура
1. Войдя в систему в режиме администратора, сделайте следующее:

a. Щелкните Expand.

b. Выберите нужный шаблон.

2. Внесите необходимые изменения

Можно изменить следующие параметры:

• отображаемый размер панелей;

• количество позиций постановки вызовов на ожидание;

• отображаемые панели.

3. Щелкните File > Save Template.

4. Введите имя шаблона и нажмите OK.

Default templates
The following three default templates are installed:

Шаблоны и профили
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Display Option Admin Template 1 Admin Template 2 Admin Template 3
Menu bar Yes Yes Yes
Tool bar Yes Yes Yes
Call details Yes Yes Yes
Directory panel Yes Yes Yes
Queue panel Yes Yes Yes
Held calls panel Yes Yes –
BLF panel Yes – –
Park slots panel Yes Yes –

If a profile is created using Admin Template 3, you cannot see the Call History panel.

Default templates
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Chapter 11: Working with Administrator 
mode

About this task
You can start the console in Administrator mode. In this mode, you can do the following:

• Create and edit user profiles.
• Amend the length of the call notes.
• Create and edit templates.
• Remove or display the BLF, Held calls, and Park slots panels.

Important:
You cannot access telephony functions in Administrator mode.

Logging into administrator mode
About this task
Use the following process to login to the console in administrator mode.

Important:
You cannot access telephony functions in administrator mode.

Procedure
1. In the Login window, enter the administrator login details. The user name is 

Administrator. The default password is password. The password can be changed 
when logged into administrator mode.

2. If intending to edit a profile, click Expand and ensure that the required profile is selected.

3. Click OK.

4. Once logged in, the status bar indicates that you are in administrator mode and not 
connected to the telephone system.
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Changing the administrator mode password
About this task
You can start the console in administrator mode. In this mode, you can do the following:

Before you begin
• Login to the console in administrator mode. See Logging into administrator mode on page 84.

Procedure
1. Click File > Change Administrator Password.

2. Enter the current Administrator mode password.

3. Enter and confirm the new password.

4. Click OK to save your changes.

Changing the administrator mode password
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Глава 12.  Поиск и устранение 
неисправностей

В этой главе приведены сведения об известных проблемах и их решения.

Дополнительные ссылки
Вы не можете использовать Force Extension Status или Group Service Status функции на 
стр. 86
Вызовы без ответа не возвращаются оператору на стр. 86
При входе в систему открывается экран предупреждения Microsoft Outlook на стр. 87
В справочнике не показаны контакты Outlook на стр. 87

Вы не можете использовать Force Extension Status или 
Group Service Status функции

Причина
Оператор не может использовать эти функции в течение нескольких секунд после запуска 
консоли. При этом в формах «Свойства записи справочника» и «Состояние обслуживания 
группы» отображается кнопка Close, а не OK или Cancel.
Решение
Закройте форму, подождите несколько секунд, а затем снова откройте форму и повторите 
попытку.

Дополнительные ссылки
Поиск и устранение неисправностей на стр. 86

Вызовы без ответа не возвращаются оператору
Причина
Чтобы вызовы возвращались оператору при отсутствии ответа, на вкладке «Телефония 
пользователя» в настройках телефонной системы должно быть задано время возврата 
передачи.
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Решение
Обратитесь к системному администратору.

Дополнительные ссылки
Поиск и устранение неисправностей на стр. 86

При входе в систему открывается экран 
предупреждения Microsoft Outlook

Причина
Экран предупреждения Outlook может появиться при входе в систему или при 
использовании функции Send Email, если на вкладке справочников выбран доступ 
справочника к папке контактов Microsoft Outlook.

Решение
1. Установите флажок Разрешить доступ на и выберите период времени из списка.
2. Нажмите Да.

Дополнительные ссылки
Поиск и устранение неисправностей на стр. 86

В справочнике не показаны контакты Outlook
Причина
Приложение Outlook должно быть запущено с правами администратора.

Решение
Обратитесь ко своей службе поддержки.

Дополнительные ссылки
Поиск и устранение неисправностей на стр. 86

При входе в систему открывается экран предупреждения Microsoft Outlook
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Chapter 13: Additional Help and 
Documentation

The following pages provide sources for additional help.

Related links
Forgotten Password on page 88
Getting Help on page 88
Additional Documentation on page 89

Forgotten Password
Some IP Office features require you to enter information such as your username, password, login 
code (security PIN), voicemail code (mailbox password).
Avaya cannot or reset the values for your passwords and codes. However, your system 
administrator can reset the values if necessary, either doing it theirself or through a request to 
your Avaya business partner.
Your system administrator also sets the rules your IP Office system uses for allowable passwords 
and codes. The same rules are applied to all users.

Related links
Additional Help and Documentation on page 88

Getting Help
Avaya sells IP Office through accredited business partners. Those business partners provide 
direct support to their customers and escalate issues to Avaya if necessary.
If you require further support, you should first contact your own system administrator. They are 
able to access the full configuration of the IP Office system, either theirself or through a request to 
your system's Avaya business partner.
Whilst your system administrator/reseller cannot see your existing passwords, they can reset them 
in order to allow you to login again and then change the value.
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Related links
Additional Help and Documentation on page 88

Additional Documentation
The Avaya Центр документации website contains user guides and manuals for Avaya products. 
The links below cover user guides that you may find useful.

Phone User Guides
• IP Office — Руководство пользователя для телефона серии J100 | IP Office — Краткое 

справочное руководство по серии J100
• IP Office — Руководство пользователя для телефона серии 9600 | IP Office — Краткое 

справочное руководство по серии 9600
• IP Office — Руководство пользователя для аналогового телефона

Application Guides
• Использование Клиент Avaya Workplace для IP Office
• Использование портала пользователей IP Office
• Использование one-X Portal для IP Office
• Использование IP Office SoftConsole

Voicemail Mailbox User Guides
• Использование почтового ящика в режиме Voicemail Pro IP Office
• Использование почтового ящика в режиме Voicemail Pro Intuity
• Использование режима Intuity в IP Office Embedded Voicemail
• Использование режима IP Office в IP Office Embedded Voicemail

Related links
Additional Help and Documentation on page 88

Additional Documentation
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